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Development of a complete computing system of interfaces based on ARM.

Hardware used: Terasic DE1-SoC Board
Software used: Quartus 22.1

Tutorial 6
Creation of a computing system equipped with both standard and custom peripherals, based on an ARM processor
Description: In this tutorial you will create a system consisting of an ARM processor and various peripherals both custom and made by third parties. 
Purpose: The aim is to see how an entire computing system can be created within a single FPGA and how this system can be used to interact with the outside world through peripherals already developed by third parties or even by developing the most suitable peripheral to create a certain interface to the outside.
Expected learning:  
· In-depth study of the Quartus "Platform Designer" tool to create a processor together with its interface system
· Configuring the processor and third-party peripherals
· Creation of "ad hoc" peripherals
· Processor programming and code execution in a Codesign "Hardware-Software" process
Premise
A modern FPGA contains both resources to create dedicated hardware, but also specific resources that create computing, control and interface systems to the outside world according to the most common protocols in order to create what is commonly called System On Chip (SoC). In particular, the FPGA mounted on the DE1-SoC has already integrated a dual Core ARM processor in hardware form as well as EMACs, USB Controllers, I2C Controllers, UARTs, CAN Controllers, SPI Master Controllers, SPI Slave Controllers, GPIO Interfaces etc. etc.
 In this tutorial we will see how to interact with these elements to create an ad hoc calculation and interface system, choosing in particular which processing is most appropriate to be carried out in hardware and which in software.
Realization of the architecture

Start by creating the "skeleton" of a system using the "System Builder" tool that involves the use of 
· HPS (Hardware Processor System)
· Leds
· 7-segment display
· Swithes
· Keys
· Clock
· SystemID
· GPIO0 and GPIO1 (in default mode)
[image: ]
Not all of these peripherals will be used at first, but their presence will be useful later without having to reconsider the project from the beginning.
Open the project thus generated within Quartus.
Inside Quartus:
Tools > Platform Design

This opens up a system that allows you to configure the architecture based on blocks already developed by third parties. 
[image: ]
A first block is already present and is a block useful for managing the clock and reset, but this will be replaced with another one that can also be used for projects that should for example use the external memory (SDRAM) present on the DE1-SoC
Therefore, include the following blocks
· System and SDRAM clock For DE1-series Boards (the soft processor)
· JTAG_to_HPS_Bridge (the interface that allows the JTAG to access HPS resources)
· ARM_A9_HPS (the ARM processor)
· JTAG_to_FPGA_Bridge (the interface that allows the JTAG to access the FPGA's resources)
· Two JTAG UART INTEL FPGA IP (The STDIO serial interface to communicate with the processor) to interface with the two ARM processors
· Three  suitably sized Intel FPGA IP (Parallel I/O) PIO-type interfaces (to interface with Switches, LEDs and KEYs, respectively) 
· System ID Peripheral Intel FPGA IP (System Identifier – SysID)

The window with the architecture should look more or less like this:
[image: ]

Rename the various blocks appropriately and configure the connections as follows:
· The clock signal output from the "System PLL" is connected to all the blocks and in particular to the 3 interfaces of the ARM
· The Reset signal output from the clock generator is connected to all blocks
System > Create Global Reset Network
· The ARM h2f_lw_axi_master line  reaches all blocks used as a peripheral 
(i.e. the ARM reads/writes data from all blocks through its lightweight 32-bit interface)
· Line h2f_axi_master remains disconnected
· the f2h_axi_slave line  is connected with the master port of JTAG_to_HPS_bridge (this will allow the debugging tool to be able to interact with the processor)
· Memory and hps_io signals  are exported to the FPGA
· The f2h_stm_hw_event signal  (if present) can remain disconnected 
· The f2h_irq0 and f2h_irq1 signals  are connected to the two interfaces respectively JTAG_UART_For_ARM
· Check that all interfaces (Led,Switches,Button,SysID, Bridge-x2, UART-x2) receive 
· The clock from System PLL
· The Reset from: 
· SystemPLL
· JTAG2HPS Bridge
· JTAG2FPGA Bridge
· ARM (from port h2f_reset)
· Check that all interfaces to the outside (Led,Switches,Button,SysID) receive 
· on the slave port (S1) the signals coming from
· JTAG2FPGA Bridge
· ARM (from port h2f_lw_axi_master)
· Export all interface signals (conduit) to the outside and assign a name if necessary
Now let's define (manually or automatically) the appropriate memory addresses for the various blocks. The automatic procedure can be useful in this sense 
System > Assign Base Address

And define (manually or automatically) the "interrupt numbers"
System > Assign Interrupt Numbers

The architecture defined so far should resemble the one shown in the figure.
Now you have to carefully configure all the various blocks and in particular the ARM Processor which reflects in its structure the use of the interfaces already provided on the De1_Soc card.
In particular, the 
· Fpga Interface is used to configure all the various interfaces and interrupts deriving from the various peripherals that make up the HPS
· Peripherals Pins define which HPS peripherals are activated and which default pinout setting to refer to. For example: since in the De1-SoC board at the HPS55 and HPS56 pins there is already an accelerometer installed whose I2C port belongs precisely to those pins, obviously if you want to use it you will have to ensure that the I2C Controller I2C0 is assigned to the HPS I/O set0 I/O set. The same applies, for example, to controllers to access the SD memory or the USB interface or even the Ethernet port, etc. etc. Another example are the HPS53 and HPS54 pins that have been connected respectively to an LED and a button accessible only through HPS and therefore if you want to use them they must be exported through the appropriate connection table.
· HPS Clocks (in turn divided into Input clocks and Output clocks) defines the frequencies of the clocks pertaining to the various peripherals and eventually exports them
· SDRAM (in turn divided into subfolders) defines all the parameters for suitable communication to the SDRAM.
Since the complete setting of all these parameters, which must reflect the physical characteristics of the circuit on which the FPGA is mounted, can be quite expensive, it is advisable to draw inspiration from the file available on the Moodle page of the course, or from the software material provided together with the De1-SoC sheet.
Once the processor and peripheral architecture is complete, take note of the addresses to which the various peripherals are mapped.
You might also want to see an example of how to instantiate the component:
Generate > Show Instanstation Template 
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Which can be taken as a cue to subsequently instantiate the component within the top level entity.
Now you can build the complete architecture
< Generate HDL>
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Choose if you want to create the symbol (useful within a schematic if necessary) or the verilog files to carry out a suitable simulation in Verilog – But both options will not be used in this tutorial
< Generate >

And then

< Close >
< Finish >

Probably at the end of the process you will see a window reminding you where the files to be manually included in the project have been stored.

Instantiation of the architecture within the project

The architecture generated in the previous step must now be imported at the global system level and interfaced with any other blocks and signals.
For example, it is necessary to ensure that the clock and an appropriate reset signal arrive at the architecture and its I/O signals related to leds, keys and switches connect to the corresponding pins inside the DE0-SoC board. In addition, it must also be ensured that the various HPS pins dedicated to the connection to external peripherals (such as DDR3, USB, ENET, FLASH, I2C, GPIO, ... ) that are shared externally in the instance of the previously made component, find an appropriate physical connection to the corresponding components mounted on the DE1-SoC board.
So at the level of the "Top Level Entity" generated with the "system builder" tool you will need to create all the appropriate connections:
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An example file with the above instantiation is available on the moodle page relating to the course, but you must pay particular attention to the fact that the names of the signals reported are consistent with those assigned to the signals "exported" within the "Platform Designer" tool and if you have opted for different names, it will be advisable to modify the instantiation file accordingly as well. Also note that the signal used for the reset in this case is the inverted KEY[0] signal  !
Finally, at the system level, you still need to include the generated ".qip" file in the project.
Project > Add/Remove files in project

Click on the three dots
Go to find the file where it was previously indicated by the dialog box and import it.
<OK>
At this point the entire system can be compiled.
ONLY  run  the "Analysis and Synthesis" process
Then you have to execute two scripts to make an appropriate assignment of the parameters and the assignment of the pins related to HPS that impose appropriate constraints regarding the "Placement", "Mapping" and "Routing" phases
Tools > TcL scripts

And double-click on 
hps_sdram_p0_parameters.tcl
hps_sdram_p0_pin_assignments.tcl
You only need to do this once per project, and you don't need to run it again if you make changes to the architecture.
At this point you can complete the compilation of the project and download it to the card.
The Hardware Part inherent in the implementation of the system is completed and you can close Quartus.
Intel FPGA Monitor Program

Launch "Intel FPGA Monitor Program"
File > New Project
Define an appropriate directory (it is suggested to create, within the project created with Quartus, a suitable directory – called for example "software", in which to reside the project that now continues in the creation of an appropriate software for controlling the processor just created). Assign a name to the project and choose ARM Cortex A9 as the architecture
> Next
As the type of architecture, choose <Custom>, then indicate the files that characterize the hardware system .sopcinfo and .sof located in the directory where the hardware of the project resides, as a pre-loader the one relating to the DE1-Soc card and as a preloader choose the one relating to the card you are using.

> Next 
As a type of programming at the moment choose <No Program>
> Next

Then define the processor and communication interface in "Connection Settings"
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> Save

The system will ask if you want to load the configuration file on the board, but if you have a small bug in the system it is better to skip this point and use Quartus to program the board (as already done).
Action > Connect to System 

Access the Memory tab
Goto Address go to the addresses where LEDs, Swithes and SysIDs have been mapped (e.g. 0xff200000), check "Query Device"
> GO

At this point you can see the various peripherals through their memory addresses:
- by writing some data (e.g. 0x2AA to the relative location of the LEDs) you will see the LEDs light up alternately)
- by activating a configuration on the switches and clicking <Refresh> you will see this configuration mapped in memory 

- the SysID location will be mapped to the value set via Hardware during the architecture definition phase

- Pressing the Reset button (Key[0]) will turn off the LEDs

The values changed since the previous reading are shown in red.
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Access to other embedded peripherals

In addition to the peripherals made on FPGAs and expressly integrated using "Platform Design", the HPS integrated within the CycloneV presents, made in hardware, many other peripherals (ENET, USB, UART, I2C, SPI, ....) of which some have been connected to appropriate compatible devices on the DE1-SoC board, others have remained unused. In particular, we see that two GPIO pins controlled EXCLUSIVELY by the HPS (the hps_io_hps_io_gpio_inst_GPIO53 and hps_io_hps_io_gpio_inst_GPIO54) pins have been connected respectively to a dedicated LED and a dedicated button arranged on the DE1-SoC board.
They are therefore visible at an appropriate memory location and controllable/observable through a certain procedure.
Information on the various HPS peripherals and in particular on the GPIO peripherals can be found in the documents: 
· Cyclone® V Hard Processor System Technical Reference Manual
· Cyclone V HPS Register Address Map and Definitions
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In particular, they find that the different GPIO pins accessible through HPS are grouped in three different banks whose driver is accessible in a precise memory location
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While the various registers used to control the driver are accessible in adjacent memory locations.
Now taking into consideration the LED, connected to the HPS_GPIO53, it can be deduced that it is accessible through the gpio1  driver mapped to the 0xff709000 and subsequent locations.The documentation shows that in order to turn on the LED, you must first define the direction of the I/O port for HPS_GPIO53 and configure it as an output.
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This can be done by activating the position bit 24 at address 0xff709004 and then activating bit 24 at address 0xff709000 (i.e. by writing the value 0x01000000 to both locations).
First of all, note that this operation changes the state of bit 24 also at location 0xff709050 (dedicated to reading GPIOs) which passes from the value 0x1FE7FFFF to the value 0x1EE7FFFF (after activating the output mode but with bit24 still at 0) and then returns to the value 0x1FE7FFFF after turning on the LED.
While the reading of the state of the button can be operated similarly based on the value assumed by the position bit 25 always in the location responsible for reading the GPIO 0xff709050 whose value changes from 0x1FE7FFFF when the button is not pressed to 0x1DE7FFFF when the button is pressed.
[image: ]

Creation of generic peripherals to be interfaced with the processor.

Just as dedicated peripherals, developed by third parties, available in the "IP Catalog" of the "Platform Design" tool, have been included in the processor architecture, so Custom peripherals made ad hoc to handle specific problems can be integrated into the processor. These peripherals will use the "AvalonMM" bus as a means of communication to the processor and to the outside world of "conduit" connections. To get ideas on how to write a dedicated peripheral, you can draw inspiration from the codes relating to the peripherals used so far.
Open Quartus by importing the previous project.
Within the "Project Navigator" window put in "Hierarchy" mode, by opening the subblocks constituting the processor developed in the previous step, certain interface blocks (Led, Switch, SySID) can be recognized. Clicking on them gives you access to their code which can be useful as inspiration to see what signals are involved and how they are managed to obtain the dedicated results.
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Focusing on the SysID, it can be seen that the signals with which the processor queries this peripheral is essentially the address bus (which in this case is a single bit) and that when this bit is set to 1 the interface interprets this value as a query, consequently providing the value of the SysID itself on the "readdata" bus.
A little more complex is the peripheral intended to access the row of LEDs. This provides a few more control signals that allow both writing and reading on the peripheral, as well as the signal that physically connects to the LEDs (out_port)
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Basically, in order to "write" to the LEDs, the system verifies that "chipselect" is activated, that the "write_n" signal is precisely at the low level (indicating the write operation) and that "address" is zero, all obviously synchronized on the clock and with an appropriate reset signal. When all conditions are met, the data on the writedata line (of 32bit) relating to the bits [9:0] is reported on the intermediate lines "data out" and from this to "out_port". At the same time, the data that the processor reads on  the readdata  bus is the read_mux_out extended to 32bit with the addition of an appropriate number of zeros. Where the signal read_mux_out itself is composed (if the address is equal to 0) of the intermediate signal "data out" just calculated, otherwise it will be null.
A certainly interesting practice from a didactic-educational point of view could be to modify this peripheral to create a slightly different one to be replaced with the one used in the previous part of the tutorial. 
For example, let's create a peripheral where the value with which to control the LEDs resides in the most significant positions of the register that controls their ignition (instead of the least significant ones), the reset signal instead of turning off the LEDs, turns them on and where the value read is the opposite (i.e. the bit-by-bit negation) of what it would report in the current case.
Create a new Verilog file and copy the structure of the device you just scanned into it. Change the name of the module and make the changes suggested in lines 37, 39 and 43 respectively
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Save the file appropriately.
Then open the "Platform Design" tool
In the left window, double-click on "New Component"
[image: ]
In the window, provide a name for the component (interface) that you are going to make.
In the Files tab, click on <AddFile> add the File you have just created and then click on <AnalyzeFile>. If there are syntactic errors, error messages should appear here
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On the other hand, some errors related to the Interfaces appear. Then move to the interface tab and you will notice how the system has already automatically recognized, thanks to their names, some interface signals and has associated specific interfaces with them. If other names were used, it is plausible that the assignment of interfaces and signal types may have to be done manually.
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There are currently three interfaces: 
· avalon_slave_0 (with different signals)
· clock
· Reset
Note, however, that port out_port has been (mistakenly) recognized as a read data bus 
It is therefore necessary to create a new "Conduit" type interface, on which to drag the signal port_out
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And in the right window establish the "type" of signal, for example by creating an ad hoc name, in this case out_port (which will then be the name with which the signal will be located within the instance).
In addition, by clicking on the various interfaces, you can determine which are the reset and clock signals that control them.
Once the process is complete, the new component will be available among the interfaces to be included in the processor. And it can be integrated into architecture. In the image below, the new component is added to the existing ones, suitably connected to the AvalonMM and the interface signals to the outside exported and renamed.
[image: ]
At this point the processor can be generated and instantiated at the Top Level Entity level, but altering the connections in order to reflect the connection of the LEDs with this new interface:
[image: ]
By downloading the card you will immediately notice that in the reset phase all the LEDs are on, moreover the data displayed on the LEDs are related this time to the most significant bits and the reading that takes place automatically after writing returns a different value from what was written.
In the example below, when writing 0xAAAAAAAA it is noted that the value read simultaneously is 0xFFFFFD55, i.e. the 22 most significant bits are all set to 1, the 10 least significant bits are shown inverted and the LEDs light up alternately on the LED bar in the board.

Creation of other peripherals to interface with the processor.

You want to equip the processor with three additional peripherals: one that drives the seven-segment display and displays a hexagesimal code based on the data received from the processor, a timer that increases the value every microsecond, but with the possibility of setting the starting value, a rotary encoder driver that increases/decrements the value of a register based on the steps performed by the encoder in one direction or the other
The code of these devices are available on the moodle page of the course

7-segment display
The code consists of two modules: 
· SEG7_LUT is a synchronous circuit that receives a 4-bit signal as input and generates the 7 signals as output to display the corresponding digit on a single display
· my_led7seg is a higher-level system that when it receives the write signal saves the input data in an internal register (reg_data). The data in this register, grouped 4 by 4, provides the input for the previous block. They also provide the data to be read when the read line is active. At the output there are 6 separate 7-segment buses, one for each display.
Import the component into the "Platform Design" following the procedure defined above: adding the Verilog file and analyzing it, but this time, since the file contains two modules, you have to define in the same window which is the highest module in the hierarchy (obviously "my_led7seg").
In the "interface" tab create a new output interface in which to bring the 6 buses destined for the 6 displays and give each of them a unique "Type". Also connect clock and reset to all the interfaces that need it.
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Timer
This component does not require any connection outside the processor, but it can be very useful for estimating the time elapsed between two program execution points. It is basically a counter that is incremented at a constant interval Furthermore, through the SUBSAMP parameter it is possible to establish the frequency with which the counter is incremented.
As previously done 
· create a new component
· Import the description Verilog file and analyze it
· the interfaces
· on the parameters tab it is highlighted how the component has been created leaving 3 parameters adjustable: DATA_WIDTH, ADDR_WIDTH, SUBSAMP. But since the data bus must be 32-bit for a correct interface with the processor, this parameter can be deselected from the adjustable parameters. The ADDR_WIDTH is also quite redundant for operation, but we can leave it to see how the interface behaves if we were to change it. Finally, SUBSAMP is needed to set the timer frequency.

Rotary encoder
This component is actually a counter with the ability to increase/decrement the count by analyzing two periodic input signals and their relative phase shift. The count can also be set to a certain value using the write operation on the avalonMM bus, while the read operation returns the value of the counter itself.
As in the case of the Timer, this component also provides 3 adjustable parameters which, however, in practice modify the behavior of the system minimally.
As in the previous steps, create a new component by importing the available Verilog file.

Overall HPS
Import now through Platform Designer
· two Timers and adjust the parameters so that one has a period of 1 millisecond (SUBSAMP = 50000) and the other of one microsecond (SUBSAMP=50)
· a seven-segment display
· two rotary encoders – Two are made so that while one takes the signals through the GPIO from a real external rotary encoder, the other takes the signals from the buttons (KEY) in order to emulate their operation through the combined pressing of the keys.
At the Top-Level-Entity level, the component is instantiated by adding all the appropriate connections with the outside world.
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Once the project has been completely compiled and downloaded to the card, it can be accessed through the "Altera Monitor Program" and all the interface data can be found at the appropriate memory locations
[image: ]
Note in particular
· The data relating to rotary encoders whose ADDR_WIDTH is by default equal to 4 actually occupy 16 memory positions, although with all the same data 
· The Data relating to Timers are different for each reading and even when a data is written to it, the time elapsed between writing and reading means that the data is different from what is written
· The data in position 0xFF2000A0 are relative to the buttons
· The data in position 0xFF2000B0 are related to the switches
· The data in position 0xFF2000C0 are relative to the LEDs
· The data written in position 0xFF2000D0 is shown in the same form on the seven-segment display.
Software
At this point you can write the system code in C which, by interfacing with the peripherals, performs the desired function.
<Continue>
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Synthesis files are used to compile the system in a Quartus project.

Create HDL design files for synthesis: |Verilog

(] Create timing and resource estimates for third-party EDA synthesis tools.
(7] Create block symbol file (.bsf)

[ Simulation

The simulation model contains generated HDL files for the simulator, and may indude simulation-only features.

Simulation scripts for this component will be generated in a vendor-specific sub-directory in the specified output
directory.

Follow the guidance in the generated simulation scripts about how to structure your design's simulation scripts
and how to use the jp-setup-simulation and ip-make-simscript command-line utilities to compile all of the files
needed for simulating all of the IP in your design.

Create simulation model: None v
[ Output Directory
Path: C:/Altera/TuotialsQuartus22/ Tut6 ARMv1/Tut6v0

Cancel
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23.2. GPIO Interface Block Diagram and System Integration

The figure below shows a block diagram of the GPIO interface. The following table shows a pin table of the GPIO interface:

Figure 131. Cyclone V SoC GPIO

Reset | gpio_rst_n[n] GPIO Interface
E—
M
anager Interrupt& | |9pio_intr_in Cortex A9 Subsystem
C tpl P! Core Generic Interrupt
Clock dk > oniro Controller
Manager 1
Register
m GPI0[28:0] P00 Block
GPIO[57:29] 01
GPI0[66:58]
) E—
3 02 T
HLGPI[T3:] fegoce
< L4 Peripheral Bus >
Table 212. GPIO Interface pin table
Pin Name Mapped to GPIO Signal Name Comments
GPIO [28:0] GPIO 0 [28:0] Input / Output
GPIO [57:29] GPIO 1 [28:0] Input / Output
GPIO [66:58] GPIO 2 [8:0] Input / Output
HLGPI [13:0] GPIO 2 [26:13] Input only

Related Information
Cyclone V Device Handbook Volume 1: Device Interfaces and Integration




image11.png
GPIO Module Address Map
Registers in the GPIO module

Module Instance | Base Address
gpioo BxFF708000
gpiol BxFF709000
gpio2 BXFF70A000
GPIO Module

Register Offset Width |Access| Reset Value Description
gpio swporta dr oxe 32 RW oxe Port A Data Register
gpio swporta ddr ox4 32 RW oxe Port A Data Direction Register
gpio inten ox30 32 RW oxe Interrupt Enable Register
gpio intmask ox34 32 RW oxe Interrupt Mask Register
gpio inttype level ox38 32 RW oxe Interrupt Level Register
gpio int polarity ox3C 32 RW oxe Interrupt Polarity Register
gpio intstatus ox40 32 RO oxe Interrupt Status Register
gpio raw intstatus ox44 32 RO oxe Raw Interrupt Status Register
gpio debounce ox48 32 RW oxe Debounce Enable Register
gpio porta eoi ox4c 32 Wo oxe Clear Interrupt Register
gpio ext porta ox50 32 RO oxe External Port A Register
gpio 1s sync ox60 32 RW oxe Synchronization Level Register
gpio id code ox64 32 RO oxe ID Code Register
gpio ver id code ox6C 32 RO 0x3230382A | GPIO Version Register
gpio config_reg2 ox70 32 RO OXx39CFC Configuration Register 2
gpio config_regl ox74 32 RO Ox1FFOF2 Configuration Register 1
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Bit

Name
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28:0
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// inputs:
address,
chipselect,
clk,
reset_n,
write_n,
writedata,

// outputs:
out_port,
readdata

out_port;
readdata;
address;
chipselect;
clk;
reset_n;
write_n;
input [ 31: 0] writedata;

wire clk_en;

reg [ 9: 0] data_out;
wire [ 9: 0] out_port;
wire [ 9: 0] read_mux_out;

wire [ 31: 0] readdata;
assign clk_en = 1;
//sl, which is an e_avalon_slave
assign read_mux_out = {10 {(address == 0)}} & data_out;
always @(posedge clk or negedge reset_n)
begin
if (reset_n == 0)
data_out <= 0;
else if (chipselect & ~write_n && (address == 0))
data_out <= writedata[9 : 0];
end

{32'b0 | read_mux_out};
data_out;

assign readdata
assign out_port

endmodule
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t <= 10'b1111111111;

ipselect & ~write_n && (address == 0))
t <= writedata[31 : 22];

~{32'b0 | read_mux_out}
data_out;

@ myLEDSy X

@ Compilation Report - TUtGARM X




image17.png
& Component Editor - my_strange_LEDS_hw.tcl* X

File Templates Beta View

[Messages™ 7] -oo

© To Do: Add HDL files on the Files tab, or add signals on the Signals tab.

Help 4 Prev Next » Finish...





image18.png
& Component Editor - my_strange LEDS_hw.tcl*

X
File Templates Beta View
[ Component Type 2| Block Symbol zz- Parameters | Signals & Interfaces 5 =

» About Files

| Synthesis Files

These files describe this component's implementation, and will be created when a Quartus synthesis model is generated.

The parameters and signals found in the top-level module will be used for this component's parameters and signals.

Output Path Source File

Attributes
Top-level File

AddFile... Remove File  Analyze Synthesis Files ~ Create Synthesis File from Signals

Top-level Module: [myLEDS

Verilog Simulation Files
These files will be produced when a Verilog simulation model is generated.

Output Path Source File Type

MHarH

Attributes

AddFile...  Remove File  Copy from Synthesis Files

[/ Warning: avalon_slave_0: Signal readdata appears 2 times (only once is allowed)
@ Error: avalon_slave_0: Interface must have an associated dlock
@ Error: avalon_slave_0: Interface must have an associated reset
@ Error: avalon_slave_0: Interface must have an associated clock.

Help 4 Prev | Nexth

Finish...





image19.png
& Component Editor - my_strange_LEDS_hw.tcl*

X
File Templates Beta View
[ Component Type [ Block Symbol [ Files | Parameters zz_ =
| + About Signals
\ Name: avalon_slave_0 Documentation
|
o address (2] actiess Type: Avalon Memory Mapped Slave v
o chipselect [1] chipselect Associated Clock: |none v
= out_port [10] readiata i
< readdata [32] readdata Assodiated Reset: none A
o write_n [1] wite_n . . ;
| | o writedata [32] wiitedsts ASigpes Eli
<<add signal>>
o-dock Clock Input - Block Diagram | # |- Parameters
o dk [1] dk Address units: WORDS v
w-reset Resel Input :
o reset_n [1] reset 1 avalon_slave_0 Associated clock:
<<add signal>> avalon_slave_0| Assodciated reset:
<<add interface>> adress
chipselect Bits per symbol: 8
write_n lits:
Wi Burstcount units: WORDS
readdata Explicit address span: 00000000000000000000
readdata
] | Fiming
‘ Setup: 0
|
Read wait: 1
Write wait: 0
Hold: 0
Timing units: Cycles v
\
[ Pipelined Transfers
\
oo

@ Error: avalon_slave_(
@ Error: avalon_slave_(
@ Error: avalon_slave_(

[/ Warning: avalon_slave_0: Signal readdata appears 2 times (only once is allowed)
Interface must have an associated clock
Interface must have an associated reset
Interface must have an associated clock.

Help

4 Prev Next b Finish...





image20.png
& Component Fditor - my_strange. |

DS el

Fle Termplstes Bets View

Conponnt Type | Bork Smbol | i | porameters [ GRRRBIRRAREE]

el
 About Signds.
e Nome: g |
avalon siave 0 A oo | SonalTypes oot |
wan o
Orecton: ot
<cotd oo
el
10 Tfo: o errrs or wernings.

Wy mer | Neds  rim




image21.png
[EEISTRECSIEREN Acress vap

Interconnect Requirements &<

~ W System: Tut6v0 Path: LEDs

Har M fAIXg@+

Use Connections

Name

51 System_PLL
ref_dk
ref_reset
sys_dk
sdram_ck
reset_source

51 JTAG_to_HPS_Bridge
dk
clk_reset
master
master_reset

518 ARM_A9_HPS
f2h_stm_hw_events
memory
hps_io
h2f_reset
h2f_axi_dock
h2f_axi_master
f2h_axi_clock
f2h_axi_slave
h2f_Iw_axi_clock

2% JTAG_to_FPGA_Bridge
dk
clk_reset
master
master_reset
= LEDS
dk
reset
s1
external_connection
o Slider_Switches
dk
reset
s1
external_connection
B Pushbuttons
dk
reset
s1
external_connection
irq
B JTAG_UART_for_ARM_0
dk
reset
avalon_jtag_slave
irg
B JTAG_UART_for_ARM_1
dk
reset
avalon_jtag_slave
irq
B SysID
dk
reset
control_slave
5 my_strange_LEDS_0
avalon_slave_0
dock
reset
conduit_end

Description
System and SDRAM Clocks for DE-series Boards
(Clock Input

Reset Input

Clock Output

Clock Output

Reset Output

ITAG to Avalon Master Bridge

Clock Input

Reset Input

Avalon Memory Mapped Master

Reset Output

\Arria V/Cyclone V/ Hard Processor System
Conduit

Conduit

Conduit

Reset Output

Clock Input

|AXI Master

Clock Input

AXI Slave

Clock Input

|AXI Master

Interrupt Receiver

Interrupt Receiver

ITAG to Avalon Master Bridge

Clock Input

Reset Input

Avalon Memory Mapped Master

Reset Output

Clock Input

Reset Input

|Avalon Memory Mapped Slave
Conduit

PIO (Parallel 1/0) Intel FPGA IP
Clock Input

Reset Input

Avalon Memory Mapped Slave
Conduit

PIO (Parallel 1/0) Intel FPGA IP
(Clock Input

Reset Input

|Avalon Memory Mapped Slave
Conduit

Interrupt Sender

ITAG UART Intel FPGA IP
Clock Input

Reset Input

Avalon Memory Mapped Slave
Interrupt Sender

ITAG UART Intel FPGA IP
(Clock Input

Reset Input

|Avalon Memory Mapped Slave
Interrupt Sender

System ID Peripheral Intel FPGA IP
Clock Input

Reset Input

Avalon Memory Mapped Slave
my_strange_LEDS

|Avalon Memory Mapped Slave
(Clock Input

Reset Input

(Conduit

Export

'system_pll_ref

memory
hps_io

leds

leds_1

[h2f_ax.

[f2h_ax.

[h2f_w.

Syste.

[dk]

Syste...
[ck]
[kl

Syste...
[ck]
[kl

Syste.
[ck]
[kl

[kl

Syste.
[ck]
[ck]
[kl

Syste...
[ck]
[ck]
[kl

Syste...
[ck]
[kl

[dock]
Syste.
[cdlock]
[dock]

a 0x0000_0000

IRQ 0|
IRQ 0|

a 0x0000_00c0

& 0x0000_00b0

& 0x0000_00a0

& 0x0000_0138

& 0x0000_0130

& 0x0000_0120

0x0000 0000

End RQ Tags
OxfEff FFFF

IRQ 31fFy

IRQ 31

0x0000_00cE

0x0000_00bE

0x0000_00af

0x0000_013£

0x0000_0137

0x0000_0127

0x0000_000£





image22.png
// External

//-leds_export

. sw_export
.keys_export
.leds_1_out_port

(LEDR[9:01),
(sw[9:0]1),
(KEY[3:01),
(LEDR[9:0])

//
/7

//

Tledr.export
Sw.export
keys.export




image23.png
A Component Editor - my_Display7SEG_hw.tcl* X

File Templates Beta View

[ Component Type [ Block Symbol [ Files | Parameters zz_ =

+ About Signals
Name Name:  |hext
»-avalon_slave_0 4va/on Memor| | Signal Type: lout_dispf -]
o address [1] address )
o read [1] read URE  [cd
== readdata [32] readota Direction: |output S
o write [1] write

o= writedata [32] writedatz
<<add signal>>
»-clock Clock Input
o dk [1] ok
»-conduit_end Conduit
< hexa (7] out_dispa
< hexb [7] ot dispb
< hexc [7] out_dispc
< hexd [7] ot dispd
< hexe [7] o

<<add signal>>
o-reset Resel Input
o reset_n [1] reset
<<add signal>>
<<add interface>>

[Messages 1] -oo

© Info: No errors or warnings.

Help 4 Prev Next b Finish...





image24.png
.display_out.
.display_out_dispf
.encO_datal
.encO_datarl
.enc0_data2
.enc0_datar2
.encl_datal

// External

.Teds_export
. sw_export
.keys_export

.display_out_dispa
.display_out_di
.display_out_¢

.display_out_di

.encl_datarl
.encl_data2
.encl_datar2

<7

(LEDR[9:01),
(sw[9:01),
(KEY[3:0]),

(HEX0),

(HEX1),

(HEX2),

(HEX3),

CHEX4),

CHEX5),
(GPIO1GPIO[0]),
Q,
(GPIOLGPIO[1]),
O,

(KEY[3D),

O,

(KEY[2D),

O

1/
7/

Tedr.export
sw.export
keys.export

display.out_dispa
.out_dispb
.out_dispc
.out_dispd
.out_dispe
.out_dispf
enc0.datal

encl.datal
.datarl
.data2
.datar2




image25.png
4 Intel FPGA Monitor Program - TutbARM : Connect to System [Paused]
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